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Important Information

Warranty

Copyright

Trademarks

The GPIB hardware is warranted against defects in materials and workmanship for a period of two years from the date
of shipment, as evidenced by receipts or other documentation. National Instruments will, at its option, repair or replace
equipment that proves to be defective during the warranty period. This warranty includes parts and labor.

The media on which you receive National Instruments software are warranted not to fail to execute programming
instructions, due to defects in materials and workmanship, for a period of 90 days from date of shipment, as evidenced
by receipts or other documentation. National Instruments will, at its option, repair or replace software media that do not
execute programming instructions if National Instruments receives notice of such defects during the warranty period.
National Instruments does not warrant that the operation of the software shall be uninterrupted or error free.

A Return Material Authorization (RMA) number must be obtained from the factory and clearly marked on the outside
of the package before any equipment will be accepted for warranty work. National Instruments will pay the shipping costs
of returning to the owner parts which are covered by warranty.

National Instruments believes that the information in this manual is accurate. The document has been carefully reviewed
for technical accuracy. In the event that technical or typographical errors exist, National Instruments reserves the right to
make changes to subsequent editions of this document without prior notice to holders of this edition. The reader should
consult National Instruments if errors are suspected. In no event shall National Instruments be liable for any damages
arising out of or related to this document or the information contained in it.

EXCEPT AS SPECIFIED HEREIN, NATIONAL INSTRUMENTS MAKES NO WARRANTIES, EXPRESS OR IMPLIED, AND SPECIFICALLY DISCLAIMS
ANY WARRANTY OF MERCHANTABILITY OR FITNESS FOR A PARTICULAR PURPOSE. CUSTOMER’S RIGHT TO RECOVER DAMAGES CAUSED
BY FAULT OR NEGLIGENCE ON THE PART OF NATIONAL INSTRUMENTS SHALL BE LIMITED TO THE AMOUNT THERETOFORE PAID BY THE
CUSTOMER. NATIONAL INSTRUMENTS WILL NOT BE LIABLE FOR DAMAGES RESULTING FROM LOSS OF DATA, PROFITS, USE OF PRODUCTS,
OR INCIDENTAL OR CONSEQUENTIAL DAMAGES, EVEN IF ADVISED OF THE POSSIBILITY THEREOF. This limitation of the liability of
National Instruments will apply regardless of the form of action, whether in contract or tort, including negligence.

Any action against National Instruments must be brought within one year after the cause of action accrues. National
Instruments shall not be liable for any delay in performance due to causes beyond its reasonable control. The warranty
provided herein does not cover damages, defects, malfunctions, or service failures caused by owner’s failure to follow
the National Instruments installation, operation, or maintenance instructions; owner’s modification of the product;
owner’s abuse, misuse, or negligent acts; and power failure or surges, fire, flood, accident, actions of third parties, or
other events outside reasonable control.

Under the copyright laws, this publication may not be reproduced or transmitted in any form, electronic or mechanical,
including photocopying, recording, storing in an information retrieval system, or translating, in whole or in part, without
the prior written consent of National Instruments Corporation.

CVI™, HS488™, LabVIEW ™, NAT4882™, natinst.com™, NI-488™, NI-488.2™, NI-488.2M™, TNT 4882™C, and
Turbo488™ are trademarks of National Instruments Corporation.

Product and company names listed are trademarks or trade names of their respective companies.

WARNING REGARDING MEDICAL AND CLINICAL USE OF NATIONAL INSTRUMENTS PRODUCTS

National Instruments products are not designed with components and testing intended to ensure a level of reliability
suitable for use in treatment and diagnosis of humans. Applications of National Instruments products involving medical
or clinical treatment can create a potential for accidental injury caused by product failure, or by errors on the part of the
user or application designer. Any use or application of National Instruments products for or involving medical or clinical
treatment must be performed by properly trained and qualified medical personnel, and all traditional medical safeguards,
equipment, and procedures that are appropriate in the particular situation to prevent serious injury or death should always
continue to be used when National Instruments products are being used. National Instruments products are NOT intended
to be a substitute for any form of established process, procedure, or equipment used to monitor or safeguard human health
and safety in medical or clinical treatment.



FCC/DOC Radio Frequency
Interference Compliance

Class A

This equipment generates and uses radio frequency energy and, if not installed and used in strict accordance
with the instructions in this manual, may cause interference to radio and television reception. Classification
requirements are the same for the Federal Communications Commission (FCC) and the Canadian
Department of Communications (DOC). The FCC/DOC classification is indicated on a label on the devices.
If an FCC ID is present, the equipment is Class B; otherwise, it is Class A. Look at the product to determine
the classification, then read the appropriate information below regarding the compliance of your product:

Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class A digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference when the equipment is operated in a commercial environment. This equipment generates, uses,
and can radiate radio frequency energy and, if not installed and used in accordance with the instruction
manual, may cause harmful interference to radio communications. Operation of this equipment in a
residential area is likely to cause harmful interference in which case the user will be required to correct

the interference at his own expense.

Canadian Department of Communications

Class B

This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe A respecte toutes les exigences du Reglement sur le matériel brouilleur
du Canada.

Federal Communications Commission

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant
to part 15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful
interference in a residential installation. This equipment generates, uses and can radiate radio frequency
energy and, if not installed and used in accordance with the instructions, may cause harmful interference
to radio communications. However, there is no guarantee that interference will not occur in a particular
installation. If this equipment does cause harmful interference to radio or television reception, which can
be determined by turning the equipment off and on, the user is encouraged to try to correct the interference
by one or more of the following measures:

* Reorient or relocate the receiving antenna.
* Increase the separation between the equipment and receiver.
* Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.

* Consult the dealer or an experienced radio/TV technician for help.

Canadian Department of Communications

This Class B digital apparatus meets all requirements of the Canadian Interference-Causing Equipment
Regulations.

Cet appareil numérique de la classe B respecte toutes les exigences du Reglement sur le matériel brouilleur
du Canada.



FCC Notices to User

Changes or modifications not expressly approved by National Instruments could void the user’s authority
to operate the equipment under the FCC Rules.

This device complies with the FCC rules only if used with shielded interface cables of suitable quality
and construction. National Instruments used such cables to test this device and provides them for sale
to the user. The use of inferior or nonshielded interface cables could void the user's authority to operate
the equipment under the FCC rules.

If necessary, consult National Instruments or an experienced radio/television technician for additional
suggestions. The following booklet prepared by the FCC may also be helpful: Interference to Home
Electronic Entertainment Equipment Handbook. This booklet is available from the U.S. Government
Printing Office, Washington, DC 20402.
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About
This
Manual

This manual contains instructions for installing and configuring the
National Instruments PCI-GPIB or PCMCIA-GPIB interface and the GPIB
software for Windows NT. The GPIB software is intended for use with
Windows NT version 4.0 or higher.

This manual assumes that you are already familiar with Windows NT.

How to Use the Manual Set

Getting Started Installation and
Manual Configuration

-~ @A A

Novice Experienced
Users Users
= Y
GPIB User NI-488.2M Function
Manual for Reference Manual
Windows 95 for Win32
and Windows NT
Application Function
Development and Routine
and Examples Descriptions

Use this getting started manual to install and configure your PCI-GPIB or
PCMCIA-GPIB and the GPIB software for Windows NT.
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About This Manual

Use the GPIB User Manual for Windows 95 and Windows NT to learn the
basics of GPIB and how to develop an application program. This manual
also contains application examples and troubleshooting information.

The NI-488.2M Function Reference Manual for Win32 contains specific
NI-488 function and NI-488.2 routine information, such as format,
parameters, and possible errors.

Organization of This Manual

The Getting Started with Your PCI-GPIB or PCMCIA-GPIB and the GPIB
Software for Windows NT manual is organized as follows:

Chapter 1, Introduction, explains how to use this manual, lists what
you need to get started, and briefly describes the GPIB hardware and
software.

Chapter 2, Installation and Configuration, describes how to install and
configure your PCI-GPIB or PCMCIA-GPIB and the GPIB software
for Windows NT.

Chapter 3, Verify the Installation, describes how to verify the hardware
and software installation.

Chapter 4, Begin to Use the GPIB Software, helps you get started with
the GPIB software for Windows NT.

Appendix A, Uninstalling the Hardware and Software, describes how
to uninstall your PCI-GPIB or PCMCIA-GPIB and the GPIB software
from Windows NT.

Appendix B, Troubleshooting and Common Questions, describes how
to troubleshoot problems and answers some common questions.

Appendix C, Specifications, describes the electrical, physical, and
environmental characteristics of the GPIB hardware and the
recommended operating conditions.

Appendix D, Customer Communication, contains forms you can use to
request help from National Instruments or to comment on our products
and manuals.

The Glossary contains an alphabetical list and description of terms that
appear in this manual, including abbreviations, acronyms, metric
prefixes, mnemonics, and symbols.
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About This Manual

Conventions Used in This Manual

The following conventions are used in this manual:

» The » symbol leads you through nested menu items and dialog box options
to a final action. The sequence File»Page Setup»Options»Substitute
Fonts directs you to pull down the File menu, select the Page Setup item,
select Options, and finally select the Substitute Fonts options from the

last dialog box.

A This icon to the left of bold italicized text denotes a caution, which advises
you of precautions to take to avoid injury, data loss, or a system crash.

bold Bold text denotes the names of menus, menu items, parameters, dialog
boxes, dialog box buttons or options, icons, windows, Windows 95 tabs,
or LEDs.

bold italic Bold italic text denotes an activity objective, note, caution, or warning.

GPIB hardware GPIB hardware refers generically to either the PCI-GPIB or
PCMCIA-GPIB board when information can apply to either board.

IEEE 488 and IEEE 488 and IEEE 488.2 refer to the ANSI/IEEE Standard

IEEE 488.2 488.1-1987 and the ANSI/IEEE Standard 488.2-1992, respectively, which
define the GPIB.

italic Italic text denotes variables, emphasis, a cross reference, or an introduction

to a key concept. This font also denotes text from which you supply the
appropriate word or value, as in Windows 3.x.

monospace Text in this font denotes text or characters that you should literally enter
from the keyboard, sections of code, programming examples, and syntax
examples. This font is also used for the proper names of disk drives, paths,
directories, programs, subprograms, subroutines, device names, functions,
operations, variables, filenames and extensions, and for statements and
comments taken from programs.

monospace bold Bold text in this font denotes the messages and responses that the computer
automatically prints to the screen. This font also emphasizes lines of code
that are different from the other examples.

monospace italic Italic text in this font denotes that you must enter the appropriate words or
values in the place of these items.
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Related Documentation

The following documents contain information that you may find helpful as
you read this manual:

e ANSIVIEEE Standard 488.1-1987, IEEE Standard Digital Interface
for Programmable Instrumentation

¢ ANSI/IEEE Standard 488.2-1992, IEEE Standard Codes, Formats,
Protocols, and Common Commands

e Microsoft Windows NT System Guide, Microsoft Corporation

Customer Communication

National Instruments wants to receive your comments on our products
and manuals. We are interested in the applications you develop with our
products, and we want to help if you have problems with them. To make it
easy for you to contact us, this manual contains comment and configuration
forms for you to complete. These forms are in Appendix D, Customer
Communication, at the end of this manual.
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Chapter

Introduction

This chapter explains how to use this manual, lists what you need to get
started, and briefly describes the GPIB hardware and software.

How to Use This Manual

Chapter 1 Gather What You Need
to Get Started

v

( | Install the GPIB Hardware

v

Chapter 2 < | Install the GPIB Software

v

| Configure the GPIB Software

v

| Verify the Installation

<+
Chapter 3
No Troubleshooting
Yes
Run Interactive Control Utility
Chapter 4 *
Review Programming
Considerations
User Manual and *
Function Reference C Write Application Program )
Manual
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Chapter 1 Introduction

What You Need to Get Started

Make sure you have all of the following items before you install your GPIB
hardware and software for Windows NT:

[J One of the following interfaces:
PCI-GPIB
PCMCIA-GPIB

[ The following 3.5 in., high density (1.44 MB) disks, which your kit
contains:

GPIB Software for Windows NT (Disk 1 of 2)
GPIB Software for Windows NT (Disk 2 of 2)

[0 Windows NT version 4.0 or higher installed on your system

Optional Equipment

Call National Instruments for more information about the following
optional equipment:

»  Serial or parallel bus extender and cables

*  Bus expander/isolator

GPIB Hardware Overview

The Plug and Play GPIB hardware, along with the GPIB software,
transforms any PC-compatible computer into a fully functional GPIB
Talker/Listener/Controller that has complete communications and bus
management capability. The TNT4882C chip on each Plug and Play GPIB
board combines the circuitry of the NAT4882 ASIC, the Turbo488 ASIC,
and GPIB transceivers to create a single-chip IEEE 488.2 interface. The
TNT4882C also implements the HS488 high-speed protocol, which
increases the maximum data transfer rate to up to 8 Mbytes/s, depending on
the computer and the system configuration. For more information about
transfer rates, refer to Appendix C, Specifications, in this manual. For more
information about HS488, refer to Chapter 7, GPIB Programming
Techniques, in the GPIB User Manual for Windows 95 and Windows NT.

The PCI-GPIB and PCMCIA-GPIB each contain one GPIB load; you can
connect up to 14 instruments to one of these interfaces. If you want to use
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more than the maximum number of instruments, you can order a bus
extender or expander from National Instruments. Refer to Appendix C,
Specifications, for more information about the hardware specifications and
recommended operating conditions.

GPIB Software Overview

The GPIB software for Windows NT includes a loadable Windows NT
kernel device driver and supporting utilities.

The GPIB software includes the following components:
e Device driver

*  Diagnostic test utility

*  Configuration utility

* Interactive control program

»  Utilities for software development and debugging

* Language interface libraries for Microsoft Visual C/C++ 2.0 or
later, Borland C/C++ 4.0 or later, and Microsoft Visual Basic 4.0
or later

*  Virtual device driver and special DOS and Windows 3 drivers for
running existing NI-488.2 for DOS and Windows 3 applications under
Windows NT

*  Example programs that use NI-488 functions and NI-488.2 routines

For a detailed list of files, refer to Chapter 1, Introduction, in the GPIB
User Manual for Windows 95 and Windows NT. Refer to Appendix C,
Specifications, for information about the GPIB software transfer rates.

Time-Saving Development Tools

Your kit includes the GPIB software for Windows NT. In addition, you
can order the LabWindows/CVI or LabVIEW software from National
Instruments to speed your application development time and make it
easier to communicate with your instruments.

LabVIEW is an easy-to-use, graphical programming environment you
can use to acquire data from thousands of different instruments,

including IEEE 488.2 devices, VXI devices, serial devices, PLCs, and
plug-in data acquisition boards. After you have acquired raw data, you
can convert it into meaningful results using the powerful data analysis
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routines in LabVIEW. LabVIEW also comes with hundreds of
instrument drivers, which dramatically reduce software development
time, because you do not have to spend time programming the low-level
control of each instrument.

LabWindows/CVI is similar to LabVIEW, except that it combines an
interactive, easy-to-use development approach with the programming
power and flexibility of compiled ANSI C code.

For ordering information, or to request free demonstration software,
contact National Instruments.
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Chapter

Installation and
Configuration

This chapter describes how to install and configure your PCI-GPIB or
PCMCIA-GPIB and the GPIB software for Windows NT.

Install the Hardware

Install the PCI-GPIB

A Caution  Electrostatic discharge can damage several components on your GPIB hardware.
To avoid electrostatic damage when you handle the hardware, touch the antistatic
plastic package to a metal part of your system chassis before you remove the
hardware from the package.

If your GPIB hardware is already installed, but this is your first time to
install the GPIB software, skip to step 8. Otherwise, complete the following
steps to install the PCI-GPIB:

1. Turn off your system. Keep the system plugged in so that it remains
grounded while you install the PCI-GPIB.

2. Remove the top cover (or other access panels) to give yourself access
to the computer expansion slots.

3. Find an unused expansion slot of the appropriate type in your
computer.

4. Remove the corresponding slot cover on the back panel of the
computer.
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Chapter 2 Installation and Configuration

5. Insert the PCI-GPIB into the slot with the GPIB connector sticking out
of the opening on the back panel, as shown in Figure 2-1. It might be
a tight fit, but do not force the board into place.

Figure 2-1. Installing the PCI-GPIB

6. Screw the mounting bracket of the PCI-GPIB to the back panel rail of
the computer.

7. Replace the top cover (or the access panel to the expansion slot).

Turn on your system and start Windows NT.

The PCI-GPIB installation is now complete. Proceed to the Install the
Software section later in this chapter.
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Install the PCMCIA-GPIB

Complete the following steps to install the PCMCIA-GPIB:
1. Turn off your system.

2. Insert the PCMCIA-GPIB card into a free PC Card (PCMCIA) socket
the same way you insert a disk into a floppy drive, as shown in
Figure 2-2. The card has no jumpers or switches to set.

Portable
/ Computer
PCMCIA
Socket
PCMCIA-GPIB
.4 Cable

Figure 2-2. Inserting the PCMCIA-GPIB
3. Turn on your system and start Windows NT.

The PCMCIA-GPIB installation is now complete. Proceed to the next
section, Install the Software.
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Chapter 2 Installation and Configuration

Install the Software

After you have installed and configured your GPIB hardware, complete the
following steps to install the GPIB software for Windows NT:

1.

Log onto your Windows NT system using the Administrator
account. The GPIB setup program must have Administrator
privileges because the program modifies the configuration registry of
your system.

Insert the GPIB Software for Windows NT (Disk 1 of 2) into an unused
drive.

Select Run... from the Start menu.
Type the following command in the dialog box:
x:\setup

where x is the letter of the drive containing the distribution disk
(usually a or b).

The software installation begins with the dialog box shown in
Figure 2-3.

ntroduction

Welcome!

Thiz inzstallation pragram will install the GPIB Software far
ditidoms MT.

Click the Mest button to start the installation.

Click the Cancel button ta quit the installation at thiz time.

Cancel

Figure 2-3. GPIB Software for Windows NT Setup Dialog Box
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Chapter 2 Installation and Configuration

The setup wizard guides you through the necessary steps to install the
GPIB software. To go back and change values where appropriate, click
on the Back button. To exit the setup program at any time, click on the
Cancel button.

Before you use the GPIB software with your PCI-GPIB or PCMCIA-GPIB,
you must reconfigure the software. Refer to the next section, Configure the
Software, for instructions on running the GPIB Configuration utility.

Configure the Software

The GPIB Configuration utility is an interactive utility you can use to
examine or modify the configuration of the GPIB driver. You must run the
GPIB Configuration utility before you use the GPIB software for
Windows NT.

Configure the Software for Your PCI-GPIB or PCMCIA-GPIB

Complete the following steps to run the GPIB Configuration utility:

1. Select Start»Settings»Control Panel and double-click on the GPIB
icon.
The GPIB Configuration utility displays a list of all the GPIB boards
and device names.

2. Inthe GPIB Configuration dialog box, select a GPIB interface from
the GPIB Board list. If you are using only one GPIB interface, select
GPIBO.

3. Click on the Board Type button and select PCI-GPIB or
PCMCIA-GPIB from the list that appears. Click on the OK button.
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Chapter 2 Installation and Configuration

Configure the Software for Your PCI-GPIB

Complete the following steps to configure the GPIB software for your
PCI-GPIB interface:

1. Click on the Configure button to bring up the PCI-GPIB
Configuration dialog box, as shown in Figure 2-4.

GFIB2 [PCI-GPIB]
Hardware Settings

00aBEd52 * | Serial Mumber

e | Bus Timing w

Disabled ¥ Cable Length for High-5peed
aK | Cancel | Help | §oftware>>|

Figure 2-4. PCI-GPIB Configuration Dialog Box

2. In the Serial Number drop-down list, highlight the appropriate serial
number.

Click on the OK button.

4. Inthe GPIB Configuration dialog box, click on the OK button to save
your changes and exit the utility.

5. In the Restart the GPIB Software? dialog box, click on the Yes
button.
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Chapter 2 Installation and Configuration

Configure the Software for Your PCMCIA-GPIB

Complete the following steps to configure the GPIB software for your
PCMCIA-GPIB interface:

1. Click on the Configure button to bring up the PCMCIA-GPIB
Configuration dialog box, as shown in Figure 2-4.

Hardmare Settings

G00nzec | Bus Timing
Cizabed - | Cable Length for Heh—Spead

0K Cancel | Help | §0ftwsre>>|

Figure 2-5. PCMCIA-GPIB Configuration Dialog Box

2. Resources are already assigned, but the resource assignments are not
necessarily conflict-free. To force new resource assignments, check
the Force Resources checkbox. For more information about resolving
resource conflicts, refer to the Resolving Resource Conflicts section in
Appendix B, Troubleshooting and Common Questions.

Click on the OK button.

4. Inthe GPIB Configuration dialog box, click on the OK button to save
your changes and exit the utility.

5. In the Restart the GPIB Software? dialog box, click on the Yes
button.

To configure the GPIB software settings, continue to the Configure the
GPIB Software Settings (Optional) section. Otherwise, continue to the next
chapter, Chapter 3, Verify the Installation.
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Configure the GPIB Software Settings (Optional)

Complete the following steps to configure the GPIB software settings:

1. Select Start»Settings»Control Panel and double-click on the GPIB
icon.

2. You can configure additional items, such as the GPIB primary address
or I/O timeout, but they are normally configured at run time by your
application program. To examine or edit a setting, double-click on its
name. For more information about GPIB Configuration utility options,
refer to the GPIB User Manual for Windows 95 and Windows NT or
use the online help.

3. To save your changes and exit the utility, click on the OK button. To
discard the changes and exit the utility, click on the Cancel button.

After you install and configure the software, you should verify the
installation. Continue to the next chapter, Chapter 3, Verify the Installation.
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Chapter

Verify the Installation

This chapter describes how to verify the hardware and software installation.

You can use the Diagnostic utility, installed with your GPIB software, to
test the hardware and software installation. The Diagnostic utility verifies
that your hardware and software are functioning properly and that the
configuration of your GPIB interfaces does not conflict with anything else
in your system.

To run the Diagnostic utility, select the Diagnostic item under
Start»Programs»GPIB Software.

After you start the Diagnostic utility, test your GPIB interfaces by clicking
on the Test All button. If the Diagnostic utility test is successful, it puts a
checkmark next to the interface and changes its status from untested to
passed. If the Diagnostic utility test fails, it puts an X next to the interface,
and changes its status from untested to failed. Figure 3-1 shows the
Diagnostic dialog box after it has tested some GPIB interfaces.

GPIE Name | Interface Type | Status | -
Test Al
Bz Grieo JIGEERE passed
R GRIBT AT-GFIBATNT passed Detalls
E it
Help

GPIB Software for windows NT, werzsion 1.40

Figure 3-1. Diagnostic Utility after Testing
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To get details on any of the tested GPIB interfaces, select the interface and
click on the Details button. For each failed GPIB interface, select it and
click on the Details button to get a description of the failure. Use that
information and the information in Appendix B, Troubleshooting and
Common Questions, to troubleshoot the problem. Troubleshooting
information is also available in the Diagnostic utility online help, which
you can access by clicking on the Help button.
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Chapter

Begin to Use the
GPIB Software

This chapter helps you get started with the GPIB software for
Windows NT.

Getting Started with LabVIEW

LabVIEW is a graphical programming language in which your source code
looks like a flowchart. It provides the same functionality as other
programming languages when controlling GPIB instruments. If you
already installed LabVIEW, you can use the LabVIEW GPIB functions
without any additional installation. To learn about the basic concepts of
GPIB communication, refer to the LabVIEW GPIB functions chapter in the
LabVIEW User Manual. To learn more about each GPIB function, refer to
the LabVIEW Function and VI Overview Manual and the online help.

National Instruments provides LabVIEW instrument drivers, which are
applications that communicate to a specific GPIB instrument. LabVIEW
instrument drivers eliminate the need to learn the complex, low-level
programming commands for each instrument. For more information, refer
to Chapter 7, Getting Started with a LabVIEW Instrument Driver, in the
LabVIEW User Manual. If you want to write your own instrument driver,
National Instruments provides application notes that help you get started.

To find GPIB examples similar to your application, click on the Solution
Wizard and Search Examples buttons in the startup LabVIEW dialog box.

For more information about NI products, refer to our web site at
http://www.natinst.com/products/.

Getting Started with LabWindows/CVI

If you already installed LabWindows/CVI, you can use the
LabWindows/CVI GPIB Library without any additional installation. The
LabWindows/CVI GPIB Library includes the functions documented in
your NI-488.2 or NI-488.2M reference manual, as well as several
additional functions, which are documented in the GPIB library chapter of
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the LabWindows/CVI Standard Libraries Reference Manual. To help you
use the GPIB functions, LabWindows/CVI provides function panels for the
GPIB Library. To access the function panels, select GPIB/GPIB 488.2
from the Library menu of the Project or Source windows. For
information about using function panels, refer to the function panels
chapter in the LabWindows/CVI User Manual.

If you need to program a GPIB instrument, you might want to use an
instrument driver. An instrument driver is a set of high-level C functions for
controlling a specific instrument. The low-level steps to control the
instrument and read data are encapsulated in the high-level functions. You
can write an instrument driver yourself, or you can use one that is already
written. When you purchase LabWindows/CVI, you get free access to a
library of drivers for hundreds of instruments. For more information about
instrument drivers, refer to the project window chapter in the
LabWindows/CVI User Manual.

For more information about NI products, please refer to our web site at
http://www.natinst.com/products/.

Introduction to the Win32 Interactive Control Utility

You can use the interactive control utility to enter NI-488 functions and
NI-488.2 routines interactively and see the values returned by the function
calls. You can use this utility to do the following:

e Verify GPIB communication with your device quickly and easily.

e Learn the NI-488 functions and NI-488.2 routines before you write
your application.

e  Become familiar with the commands of your device.
e Receive data from your GPIB device.

e Troubleshoot problems with your application.

To run the Win32 Interactive Control utility, select the Win32 Interactive
Control item under Start»Programs»GPIB Software.

This utility includes extensive online help, which you can access by
entering help at the : prompt. For more information about the Win32
Interactive Control utility, refer to the GPIB User Manual for Windows 95
and Windows NT.
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Introduction to the NI Spy Utility

Included with the GPIB software is NI Spy, a Win32 utility that monitors
and records multiple National Instruments APIs (for example, NI-488.2
and VISA). You can use NI Spy to monitor Win32, Win16, and DOS GPIB
applications. Use NI Spy to do the following:

*  Capture information about NI-488 functions and NI-488.2 routines as
your GPIB applications invoke them.

» Display captured information, including, but not limited to, input and
output parameter values, I/O buffer contents, and return values.

e Save, restore, and print captured information.

To run NI Spy, select the NI Spy item under Start»Programs»GPIB
Software.

For more information about the NI Spy utility, refer to Chapter 5, NI Spy
Utility, in the GPIB User Manual for Windows 95 and Windows NT, or use
its built-in, context-sensitive online help.

Running Existing GPIB Applications

You can run existing Win32, Winl6, and DOS GPIB applications under
Windows NT.

Win32 and Winl16 GPIB applications run without any special
modifications. To run an existing DOS GPIB application, complete the
following steps.

Load the special GPIB device driver gpib-nt . com instead of gpib.com,
which you normally use with DOS. When you install the GPIB software,
the GPIB setup program copies gpib—nt . com into a new subdirectory
called doswinlé. To use gpib-nt . com, you must modify your
config.nt file to load gpib-nt . com whenever a DOS application runs.
The config.nt fileis located in your winnt\system32 directory, where
winnt is your Windows NT directory, for example, c: \windows. The
GPIB setup program modifies the config.nt file by adding the following
lines:

REM *** To run DOS GPIB applications, uncomment the

REM *** following line
REM device=path\doswinl6\gpib-nt.com
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where path is the directory in which you installed the GPIB software.

To load gpib-nt . com, locate these lines in your config.nt file and
delete REM from the third line, as follows:

REM *** To run DOS GPIB applications, uncomment the
REM *** following line
device=path\doswinlé6\gpib-nt.com

where path is the directory in which you installed the GPIB software.

General Programming Considerations

As you begin developing your Win32 GPIB application, remember the
following points:

*  For your C/C++ application, you must include the NI-488.2M header
file, dec1-32.h, in your source code.

*  You can access the GPIB software through the 32-bit DLL,
gpib-32.d11, either by linking with one of the language interfaces
provided with the GPIB software, or by using direct DLL entry from
other programming environments.

*  Several sample GPIB applications are included with the GPIB
software. Use these as a guide for your own application development.

For information about choosing a programming method, developing your
application, or compiling and linking, refer to the GPIB User Manual for
Windows 95 and Windows NT. For detailed information about each NI-488
function and NI-488.2 routine, refer to the NI-488.2M Function Reference
Manual for Win32 or the online help.
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Uninstalling the
Hardware and Software

Appendix

This appendix describes how to uninstall your PCI-GPIB or
PCMCIA-GPIB and the GPIB software from Windows NT.

Uninstalling the Hardware

Before you physically remove the GPIB hardware from your system, you
must remove the hardware information using the GPIB Configuration
utility. Complete the following steps to remove the hardware information:

1.

© MNational Instruments Corporation

Select Start»Settings»Control Panel and double-click on the GPIB
icon.

In the GPIB Configuration dialog box, select the GPIB interface you
want to remove from the GPIB Board list.

Click on the Board Type button and select None from the list that
appears, as shown in Figure A-1. Click on the OK button to save the
new Board Type setting.

Board Type

GPIE Board Board Type

AT-GPIBATHT
AT-GRIE/THTIPHP)
AT-GPIBATHT+ JEd|

ak. | LCancel | Help |

Figure A-1. Board Type Dialog Box

Click on the OK button to save your changes and exit the GPIB
Configuration utility.

Shut down Windows NT, turn off your system, and physically remove
the interface from your system.
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Uninstalling the Software

Before you uninstall the GPIB software, you should set the Board Type for
your GPIB interface(s) to None in the GPIB Configuration utility, as
described in the previous section. Complete the following steps to uninstall
the GPIB software:

1. Select Start»Settings»Control Panel and double-click on the
Add/Remove Programs icon. The dialog box shown in Figure A-2
lists the software available for removal.

Add/Remove Programs Properties K E3
Install/Uninstall | windows NT Setup |

%} Toinstall @ new program from a floppy disk or CO-RORM

drive, click Install.
Install...

T#7  The following software can be automatically removed by

el YWindows, To remowve a program or o modify itz ingtalled
compaonents, zelect it fram the list and click
Add/Remove.

Adobe Acrobat Reader 3.0 -

Data dccess Objects (DAD] 2.5

‘GPIE Software 1.40
Internet Explarer 3.0
Internet M ail and Mews 1.0

LabWIE'W 4.1
Lotuz Mates
Microzoft Developer Metwork, Library - Julp 97
Microsoft Wisual C++ 5.0 =
Add/Bemove. ..
ak. | Cancel | |

Figure A-2. Add/Remove Programs Properties Dialog Box
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2. Select the GPIB software you want to remove and click on the
Add/Remove... button. The uninstall program removes all folders,
programs, DLLs, and registry entries associated with the GPIB
software. During uninstallation, you are prompted about deleting
shared components, as shown in Figure A-3. Click on Yes, No, or No
to All to continue with the uninstallation.

Remowe Shared Eomponent

The system indicates that the following zhared file iz no longer uzed by
any programs and may be deleted.

C:WWINMT YS ystem32hibeaon fts

If any programs are still using this file and it is removed those programs
may not function. Leaving this file will not harm pour system. [F pou are
not sure what to do, you should select the No to All button. Do you want
to remove the shared file?

Figure A-3. Removed Shared Component Dialog Box

If you have not physically removed your hardware, shut down
Windows NT, turn off your system, and remove the GPIB hardware.

The uninstall program removes only items that the GPIB setup program
installed. If you add anything to a directory created by the GPIB setup
program, the uninstall program does not delete that directory. You need to
remove any remaining components yourself.

If you want to reinstall the GPIB hardware and software, refer to Chapter 2,
Installation and Configuration.
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Troubleshooting and
Common Questions

This appendix describes how to troubleshoot problems and answers some
common questions.

Troubleshooting Diagnostic Utility Failures

The following sections explain common error messages generated by the
Diagnostic utility.

Missing Software Components

This error occurs if the software components that are necessary for the
GPIB software for Windows NT to function correctly are not present in the
system. If you encounter this problem, reinstall the GPIB Software for
Windows NT and run the Diagnostic utility again.

No GPIB Interfaces Present

This error occurs if there are no GPIB interfaces physically present in the
system or there is a resource conflict with the interfaces that are installed.
If you encounter this problem, use the GPIB Configuration utility to
examine the installed GPIB interfaces and the resources assigned to each.
Then, run the Diagnostic utility again.

To access this information in the GPIB Configuration utility, complete the
following steps:

1. Select Start»Settings»Control Panel and double-click on the GPIB
icon.

2. Click on the Board Type button and verify that the type of GPIB
interface listed for each logical board name is correct. Click on the OK
button to return to the main dialog box.

3. Double-click on each board name and verify that the hardware settings
displayed in the dialog box match your actual hardware settings.
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GPIB Cables Need To Be Disconnected

This error occurs if you have any GPIB cables connected to the GPIB
interface. Disconnect all GPIB cables and run the Diagnostic utility again.

Address Resource Conflict

This error occurs if the address resources assigned to a GPIB interface
conflict with the address resources being used by other devices in the
system. To resolve an address resource conflict, refer to the Resolving
Resource Conflicts section later in this appendix. After you have resolved
the conflict, run the Diagnostic utility again.

Interrupt Resource Conflict

This error occurs if the interrupt resources assigned to a GPIB interface
conflict with the interrupt resources being used by other devices in the
system. To resolve an interrupt resource conflict, refer to the Resolving
Resource Conflicts section later in this appendix. After you have resolved
the conflict, run the Diagnostic utility again.

GPIB Software Problem Encountered

This error occurs if the Diagnostic utility detects that it is unable to
communicate correctly with the GPIB hardware using the installed GPIB
software. If you encounter this error, shut down your system, restart it, and
run the Diagnostic utility again. If the problem persists, reinstall the GPIB
software for Windows NT.

Unknown Problem Encountered

This error occurs if an unknown problem is encountered when you try to
execute the Diagnostic utility. If this error occurs, shut down your system,
restart it, and run the Diagnostic utility again. If the problem persists,
reinstall the GPIB software for Windows NT.

Resolving Resource Conflicts

Resource conflicts occur when your system contains hardware that is
configured to use the same resources as your GPIB interface. The GPIB
driver detects some resource conflicts when it loads. When the driver
detects conflicts as it loads, it records an error message describing the
conflict. You can use the Event Viewer, as described in the following
section, Using Windows NT Diagnostic Tools, to see which resource is in
conflict.
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Once you have identified the resource that caused the conflict, use the GPIB
Configuration utility to reconfigure your GPIB interface so that it uses
conflict-free resources. To help in the selection of conflict-free resources,
Microsoft has provided a utility called Windows NT Diagnostics. This
utility displays a list of the I/O port addresses, interrupt levels, and DMA
channels that your system is currently using. You can assign resources not
listed by this utility to your GPIB interface.

To run the Windows NT Diagnostics utility, select
Start»Programs»Administrative Tools»Windows NT Diagnostics.

Using Windows NT Diagnostic Tools

There are many reasons why the GPIB driver might not load. If the software
is not properly installed or if there is a conflict between the GPIB hardware
and the other hardware in the system, the GPIB driver fails to start. Two
Windows NT utilities are useful in determining the source of the problem:
the Devices applet in the Control Panel, and the Event Viewer. The
following sections describe the information available through each utility.

Examining NT Devices To Verify the GPIB Installation

To verify whether the GPIB devices are installed correctly (that is, that the
devices are started), select Start»Settings» Control Panel and
double-click on the Devices icon.

This utility lists all of the devices detected by Windows NT. Each device
has a status associated with it. If the GPIB driver is installed correctly, the
following lines appear in the list of Windows NT devices:

Device Status Started
GPIB Board Class Driver Started Automatic
GPIB Device Class Driver Started Automatic

You should also see one or more lines similar to the following:

Device Status Started
GPIB Port Driver (AT-GPIB) *kok ok System
GPIB Port Driver (PCI-GPIB) ***% System

The GPIB Board Class Driver, the GPIB Device Class Driver, and at least
one of the GPIB Port Drivers listed by the Devices applet should have a
status of started. If not, refer to the next section, Examining the NT
System Log Using the Event Viewer.
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If the GPIB Class Driver lines are not present or at least one GPIB Port
Driver line is not present, the GPIB software is not installed properly. You
should reinstall the GPIB software. Refer to Chapter 2, Installation and
Configuration, for installation instructions.

Examining the NT System Log Using the Event Viewer

Windows NT maintains a system log. If the GPIB driver is unable to start,
it records entries in the system log explaining why it failed to start. To
examine the system log by running the Event Viewer utility, select
Start»Programs»Administrative Tools»Event Viewer.

Events that might appear in the system log include the following:

*  The system cannot locate the device file for one or more of the devices
that make up the GPIB driver and an event is logged that The system
cannot find the file specified. In this case, the GPIB
software is not installed properly. You should reinstall the GPIB
software. Refer to Chapter 2, Installation and Configuration, for
installation instructions.

¢ A conflict exists between the GPIB hardware and the other hardware
in the system. If this is the case, an event is logged that indicates the
nature of the resource conflict. To correct this conflict, reconfigure the
GPIB hardware and the GPIB software. Refer to Chapter 2,
Installation and Configuration, for configuration information.

Common Questions

How can I determine which type of GPIB hardware I have installed?

Run the GPIB Configuration utility: select Start»Settings»Control Panel
and double-click on the GPIB icon.

How can I determine which version of the GPIB software I have
installed?

Run the Diagnostic utility: select the Diagnostic item under
Start»Programs»GPIB Software. The Diagnostic utility displays the
version of the GPIB software that is installed in a banner at the bottom
of the window that appears.
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Which GPIB interfaces does version 1.4 of the GPIB software for
Windows NT support?

Version 1.4 of the GPIB software for Windows NT supports the AT-GPIB,
AT-GPIB/TNT, AT-GPIB/TNT (PnP), AT-GPIB/TNT+, PCI-GPIB,
PCI-GPIB+, PCMCIA-GPIB, PMC-GPIB, PXI-GPIB, and PC/104-GPIB.

How many GPIB interfaces can I configure for use with my GPIB
software for Windows NT?

You can configure the GPIB software for Windows NT to communicate
with up to four GPIB interfaces.

How many devices can I configure for use with my GPIB software for
Windows NT?

The GPIB software for Windows NT provides a total of 100 logical devices
for applications to use. The default number of devices is 32.

Are interrupts and DMA required with the GPIB software for
Windows NT?

Interrupts are required, but DMA is not.

How can I determine if my GPIB hardware and software are
installed properly?

Run the Diagnostic utility: select the Diagnostic item under
Start»Programs»GPIB Software. Refer to the Troubleshooting
Diagnostic Utility Failures section earlier in this appendix or the online
help to troubleshoot any problems.

When should I use the Win32 Interactive Control utility?

You can use the Win32 Interactive Control utility to test and verify
instrument communication, troubleshoot problems, and develop your
application. For more information, refer to the Introduction to the Win32
Interactive Control Utility section in Chapter 4, Begin to Use the

GPIB Software.

How do I use an NI-488.2M language interface?

For information about using NI-488.2M language interfaces, refer to
Chapter 3, Developing Your Application, in the GPIB User Manual for
Windows 95 and Windows NT.
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What do I do if the Diagnostic utility fails with an error?

Use the Diagnostic utility online help, or refer to the Troubleshooting
Diagnostic Utility Failures section earlier in this appendix. If you have
already completed the troubleshooting steps, fill out the forms in
Appendix D, Customer Communication, and contact National Instruments.

How do I communicate with my instrument over the GPIB?

Refer to the documentation that came from the instrument manufacturer.
The command sequences you use are totally dependent on the specific
instrument. The documentation for each instrument should include the
GPIB commands you need to communicate with it. In most cases, NI-488
device-level calls are sufficient for communicating with instruments. Refer
to Chapter 3, Developing Your Application, in the GPIB User Manual for
Windows 95 and Windows NT, for more information.

Can I use the NI-488 and NI-488.2 calls together in the same
application?

Yes, you can mix NI-488 functions and NI-488.2 routines.

What can I do to check for errors in my GPIB application?

Examine the value of ibsta after each NI-488 or NI-488.2 call. If a call
fails, the ERR bit of ibsta is set and an error code is stored in iberr.
For more information about global status variables, refer to Chapter 3,
Developing Your Application, in the GPIB User Manual for Windows 95
and Windows NT.

What information should I have before I call National Instruments?

When you call National Instruments, you should have the results of the
Diagnostic utility test. Also, make sure you have filled out the forms in
Appendix D, Customer Communication.
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Appendix

This appendix describes the electrical, physical, and environmental
characteristics of the GPIB hardware and the recommended operating

conditions.

Hardware Characteristics

Table C-1. Hardware Characteristics for the PCI-GPIB

Characteristic

Specification

Dimensions

10.67 by 16.51 cm
(142 by 6.5 in.)

Power Requirement
(from PCI bus)

+5 VDC 300 mA  Typical
450 mA  Maximum

I/0 Connector

IEEE 488 Standard 24-Pin

Operating Environment:
Component Temperature
Relative Humidity

0°to 55°C
10% to 90%, noncondensing

Storage Environment:
Temperature
Relative Humidity

—20° to 70° C
5% to 90%, noncondensing

EMI

FCC Class B Certified
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Table C-2. Hardware Characteristics for the PCMCIA-GPIB

Characteristic

Specification

Dimensions

85.6 by 54.0 by 5.0 mm
(3.370 by 2.126 by 0.197 in.)

Power Requirement
(from PCMCIA expansion slot)

+5VDC 50mA  Typical

120 mA  Maximum

1/O Connector

Special IEEE 488 Cable with
24-Pin Converter for PC Card

Operating Environment:
Component Temperature

0°to 55°C

Relative Humidity 10% to 90%, noncondensing
Storage Environment:

Temperature —20°to 70° C

Relative Humidity 5% to 90%, noncondensing
EMI FCC Class A Certified

Software Transfer Rates

Table C-3. GPIB Software Transfer Rates for the Plug and Play GPIB Hardware

Maximum GPIB
GPIB Hardware Transfer Method Transfer Rate
3-wire (IEEE 488) 1.2 Mbytes/s*
PCI-GPIB

PCMCIA-GPIB

High Speed (HS488) 7.8 Mbytes/s*
3-Wire (IEEE 488) 1.4 MB/s*
High Speed (HS488) 1.7 MB/s*

*  Actual speed may vary considerably from speed shown because of system and

instrumentation capabilities.
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Customer Communication

For your convenience, this appendix contains forms to help you gather the information necessary

to help us solve your technical problems and a form you can use to comment on the product
documentation. When you contact us, we need the information on the Technical Support Form and
the configuration form, if your manual contains one, about your system configuration to answer your
questions as quickly as possible.

National Instruments has technical assistance through electronic, fax, and telephone systems to quickly
provide the information you need. Our electronic services include a bulletin board service, an FTP site,
a fax-on-demand system, and e-mail support. If you have a hardware or software problem, first try the
electronic support systems. If the information available on these systems does not answer your
questions, we offer fax and telephone support through our technical support centers, which are staffed
by applications engineers.

Electronic Services

Bulletin Board Support

National Instruments has BBS and FTP sites dedicated for 24-hour support with a collection of files
and documents to answer most common customer questions. From these sites, you can also download
the latest instrument drivers, updates, and example programs. For recorded instructions on how to use
the bulletin board and FTP services and for BBS automated information, call 512 795 6990. You can
access these services at:

United States: 512 794 5422
Up to 14,400 baud, 8 data bits, 1 stop bit, no parity

United Kingdom: 01635 551422
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

France: 01 48 65 15 59
Up to 9,600 baud, 8 data bits, 1 stop bit, no parity

FTP Support

To access our FTP site, log on to our Internet host, ftp.natinst.com, as anonymous and use
your Internet address, such as joesmith@anywhere.com, as your password. The support files and
documents are located in the /support directories.
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Fax-on-Demand Support

Fax-on-Demand is a 24-hour information retrieval system containing a library of documents on a wide
range of technical information. You can access Fax-on-Demand from a touch-tone telephone at

512418 1111.

E-Mail Support (Currently USA Only)

You can submit technical support questions to the applications engineering team through e-mail at the
Internet address listed below. Remember to include your name, address, and phone number so we can
contact you with solutions and suggestions.

support@natinst.com

Telephone and Fax Support

National Instruments has branch offices all over the world. Use the list below to find the technical
support number for your country. If there is no National Instruments office in your country, contact
the source from which you purchased your software to obtain support.

Country

Australia
Austria

Belgium

Brazil

Canada (Ontario)
Canada (Quebec)
Denmark
Finland

France

Germany

Hong Kong
Israel

Italy

Japan

Korea

Mexico
Netherlands
Norway
Singapore

Spain

Sweden
Switzerland
Taiwan

United Kingdom
United States

Telephone

03 9879 5166
06624579900
02 757 00 20
011 288 3336
905 785 0085
514 694 8521
45 76 26 00
09 725725 11
0148142424
089 741 31 30
2645 3186

03 6120092
02 413091

03 5472 2970
02 596 7456
55202635
0348 433466
3284 84 00
2265886

91 640 0085
08 73049 70
056 200 51 51
02 377 1200
01635 523545
512795 8248
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Fax

03 9879 6277
0662457990 19
027570311
011 288 8528
905 785 0086
514 694 4399
4576 26 02
09 725 725 55
01481424 14
089 714 60 35
2686 8505

03 6120095
02 41309215
03 5472 2977
02 596 7455
55203282
0348 430673
32848600
2265887

91 640 0533
087304370
056 200 51 55
02 737 4644
01635 523154
512794 5678
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Technical Support Form

Photocopy this form and update it each time you make changes to your software or hardware, and use
the completed copy of this form as a reference for your current configuration. Completing this form
accurately before contacting National Instruments for technical support helps our applications
engineers answer your questions more efficiently.

If you are using any National Instruments hardware or software products related to this problem,
include the configuration forms from their user manuals. Include additional pages if necessary.

Name

Company

Address

Fax (___ ) Phone (__ )

Computer brand Model Processor,

Operating system (include version number)

Clock speed MHz RAM MB Display adapter
Mouse ___yes ___no Other adapters installed
Hard disk capacity MB Brand

Instruments used

National Instruments hardware product model Revision
Configuration

National Instruments software product Version
Configuration

The problem is:

List any error messages:

The following steps reproduce the problem:




Hardware and Software Configuration Form

Record the settings and revisions of your hardware and software on the line to the right of each item.
Complete a new copy of this form each time you revise your software or hardware configuration, and
use this form as a reference for your current configuration. Completing this form accurately before
contacting National Instruments for technical support helps our applications engineers answer your
questions more efficiently.

National Instruments Products

GPIB interface type and revision

GPIB software for Windows NT version number on disk

Programming language interface version

Shield ground connected to logic ground (yes or no)

Diagnostic utility results

Board settings:

Base I/O Interrupt DMA
Address Level Channel
gpib0
gpibl
gpib2
gpib3

Other Products

Computer make and model

Microprocessor

Clock frequency or speed

Type of monitor card installed

Windows NT version

Application programming language (Microsoft C, and so on)

Other boards in system
Base /0O address of other boards
Interrupt level of other boards

DMA channels of other boards




Documentation Comment Form

National Instruments encourages you to comment on the documentation supplied with our products.
This information helps us provide quality products to meet your needs.

Title: Getting Started with Your PCI-GPIB or PCMCIA-GPIB and the GPIB Software for
Windows NT

Edition Date:  January 1998
Part Number: 321289B-01

Please comment on the completeness, clarity, and organization of the manual.

If you find errors in the manual, please record the page numbers and describe the errors.

Thank you for your help.
Name
Title

Company
Address

E-Mail Address

Phone (__) Fax (_)

Mail to: Technical Publications Faxto: Technical Publications
National Instruments Corporation National Instruments Corporation
6504 Bridge Point Parkway 512794 5678

Austin, Texas 78730-5039



Glossary

Prefix Meanings Value

m- milli- 10-3

c- centi- 102

M- mega- 106
° degrees
% percent
A amperes
ANSI American National Standards Institute
ASIC application-specific integrated circuit
C Celsius
DIP dual inline package
EMI electromagnetic interference
FCC Federal Communications Commission
GPIB General Purpose Interface Bus
Hz hertz
IEEE Institute of Electrical and Electronic Engineers
in. inches
/0 input/output
ISA Industry Standard Architecture
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Glossary

kernel

m
MB

PC

PCI
PCMCIA

RAM

VDC

set of programs in an operating system that implements basic system
functions

meters

megabytes of memory

personal computer

peripheral component interconnect

Personal Computer Memory Card International Association
random-access memory

seconds

volts direct current

PCI-GPIB/PCMCIA-GPIB for Windows NT G-2 © MNational Instruments Corporation



	Getting Started with Your PCI-GPIB or PCMCIA-GPIB and the GPIB Software for Windows NT
	Support
	Internet
	Bulletin Board
	Fax-on-Demand
	Telephone (USA)
	International Offices
	Corporate Headquarters

	Important Information
	Warranty
	Copyright
	Trademarks
	Warning

	FCC/DOC Radio Frequency Interference Compliance
	Class A
	Class B
	FCC Notices to User

	Contents
	About This Manual
	How to Use the Manual Set
	Organization of This Manual
	Conventions Used in This Manual
	Related Documentation
	Customer Communication

	Chapter 1 Introduction
	How to Use This Manual
	What You Need to Get Started
	Optional Equipment
	GPIB Hardware Overview
	GPIB Software Overview
	Time-Saving Development Tools

	Chapter 2 Installation and Configuration
	Install the Hardware
	Install the PCI-GPIB
	Install the PCMCIA-GPIB

	Install the Software
	Configure the Software
	Configure the Software for Your PCI-GPIB or PCMCIA...
	Configure the Software for Your PCI-GPIB
	Configure the Software for Your PCMCIA-GPIB

	Configure the GPIB Software Settings (Optional)


	Chapter 3 Verify the Installation
	Chapter 4 Begin to Use the GPIB Software
	Getting Started with LabVIEW
	Getting Started with LabWindows/CVI
	Introduction to the Win32 Interactive Control Util...
	Introduction to the NI Spy Utility
	Running Existing GPIB Applications
	General Programming Considerations

	Appendix A Uninstalling the Hardware and Software
	Appendix B Troubleshooting and Common Questions
	Appendix C Specifications
	Appendix D Customer Communication
	Glossary
	Figures
	Figure 2-1. Installing the PCI-GPIB
	Figure 2-2. Inserting the PCMCIA-GPIB
	Figure 2-3. GPIB Software for Windows NT Setup Dia...
	Figure 2-4. PCI-GPIB Configuration Dialog Box
	Figure 2-5. PCMCIA-GPIB Configuration Dialog Box
	Figure 3-1. Diagnostic Utility after Testing
	Figure A-1. Board Type Dialog Box
	Figure A-2. Add/Remove Programs Properties Dialog ...
	Figure A-3. Removed Shared Component Dialog Box

	Tables
	Table C-1. Hardware Characteristics for the PCI-GP...
	Table C-2. Hardware Characteristics for the PCMCIA...
	Table C-3. GPIB Software Transfer Rates for the Pl...


